## CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is an e-Dialogue?</td>
<td>2</td>
</tr>
<tr>
<td>e-Dialogues for surveys</td>
<td>4</td>
</tr>
<tr>
<td>e-Dialogues for e-learning</td>
<td>4</td>
</tr>
<tr>
<td>e-Dialogues for testing knowledge</td>
<td>4</td>
</tr>
<tr>
<td>e-Dialogues Generator - EDG</td>
<td>4</td>
</tr>
<tr>
<td>Dialogue Management System - DMS</td>
<td>4</td>
</tr>
<tr>
<td>System Requirements</td>
<td>4</td>
</tr>
<tr>
<td>Installation</td>
<td>5</td>
</tr>
<tr>
<td>First Time Installation</td>
<td>5</td>
</tr>
<tr>
<td>De-installation</td>
<td>8</td>
</tr>
<tr>
<td>Launching the Software</td>
<td>9</td>
</tr>
<tr>
<td>Keeping the Program Up-to-date</td>
<td>9</td>
</tr>
<tr>
<td>To Update Now!</td>
<td>9</td>
</tr>
<tr>
<td>Overview of the EDG window</td>
<td>10</td>
</tr>
<tr>
<td>Creating a new e-Dialogue</td>
<td>11</td>
</tr>
<tr>
<td>Opening an existing e-Dialogue</td>
<td>11</td>
</tr>
<tr>
<td>Saving an e-Dialogue</td>
<td>12</td>
</tr>
<tr>
<td>Saving with a new name</td>
<td>12</td>
</tr>
<tr>
<td>Adding, Moving and Deleting Pages</td>
<td>13</td>
</tr>
<tr>
<td>Adding, Moving and Deleting Components on a Page</td>
<td>13</td>
</tr>
<tr>
<td>General Text Editing Functions</td>
<td>15</td>
</tr>
<tr>
<td>WYSIWYG Editor</td>
<td>16</td>
</tr>
<tr>
<td>Using Native HTML</td>
<td>16</td>
</tr>
<tr>
<td>Setting the e-Dialogue properties</td>
<td>18</td>
</tr>
<tr>
<td>Setting the Look &amp; Feel</td>
<td>19</td>
</tr>
<tr>
<td>Specific Items – using images for ticks</td>
<td>21</td>
</tr>
<tr>
<td>Specific Items – using images as buttons</td>
<td>22</td>
</tr>
<tr>
<td>Specific Items – customising the header / footer</td>
<td>23</td>
</tr>
<tr>
<td>Customising text</td>
<td>24</td>
</tr>
<tr>
<td>Profiles</td>
<td>24</td>
</tr>
<tr>
<td>Settings</td>
<td>25</td>
</tr>
<tr>
<td>DMS Setup</td>
<td>25</td>
</tr>
<tr>
<td>Updates</td>
<td>26</td>
</tr>
<tr>
<td>File Locations</td>
<td>27</td>
</tr>
<tr>
<td>Proxy Server</td>
<td>28</td>
</tr>
<tr>
<td>Password Manager</td>
<td>28</td>
</tr>
<tr>
<td>Adding components to a page</td>
<td>29</td>
</tr>
<tr>
<td>Text / Images</td>
<td>29</td>
</tr>
<tr>
<td>Video / Media</td>
<td>32</td>
</tr>
<tr>
<td>Menus</td>
<td>33</td>
</tr>
<tr>
<td>Single / Multiple choice questions</td>
<td>34</td>
</tr>
<tr>
<td>Matrix questions</td>
<td>37</td>
</tr>
<tr>
<td>Drag/Drop Component</td>
<td>39</td>
</tr>
<tr>
<td>Data entry questions</td>
<td>41</td>
</tr>
<tr>
<td>Sliding scale questions</td>
<td>43</td>
</tr>
<tr>
<td>Ranking questions</td>
<td>44</td>
</tr>
<tr>
<td>Budget allocation questions</td>
<td>46</td>
</tr>
<tr>
<td>Pause</td>
<td>48</td>
</tr>
<tr>
<td>Action</td>
<td>49</td>
</tr>
<tr>
<td>Question Options</td>
<td>51</td>
</tr>
<tr>
<td>Conditional branching</td>
<td>52</td>
</tr>
<tr>
<td>Conditional item display</td>
<td>55</td>
</tr>
<tr>
<td>Random page selection</td>
<td>57</td>
</tr>
<tr>
<td>Piping</td>
<td>58</td>
</tr>
<tr>
<td>Tool Tips</td>
<td>62</td>
</tr>
</tbody>
</table>
e-Dialogues Generator User Guide v3.7.1

Option ordering ............................................................................................................................................................ 63
Scoring ........................................................................................................................................................................ 64
Weighted Scores ........................................................................................................................................................ 67
Revealing correct answers ..................................................................................................................................... 68
Using images as options ......................................................................................................................................... 69
Positioning components on a page .......................................................................................................................... 70
Single page options .................................................................................................................................................. 71
Adding languages .................................................................................................................................................. 73
Importing/Exporting language text ....................................................................................................................... 75
Export Text for Review ......................................................................................................................................... 75
Advanced Features ............................................................................................................................................... 76
Scripting ................................................................................................................................................................. 76
Conditional branching based on variables ............................................................................................................. 78
Default and Hide settings ....................................................................................................................................... 78
Auto-registration .................................................................................................................................................... 79
Display Effects ...................................................................................................................................................... 80
Tools ......................................................................................................................................................................... 82
The library ............................................................................................................................................................... 82
The Spell Checker ..................................................................................................................................................... 86
Search / Replace .................................................................................................................................................... 86
Validate ................................................................................................................................................................. 87
Validation ............................................................................................................................................................... 87
Changing the display ............................................................................................................................................. 88
Exporting from EDG to DMS ................................................................................................................................. 89
Importing from DMS to EDG .................................................................................................................................. 92
Importing from DMS Knowledge base .................................................................................................................... 93
Creating NICE Files ............................................................................................................................................. 94
Screen Capture ........................................................................................................................................................ 95
Creating SCORM Files ......................................................................................................................................... 96
Help ......................................................................................................................................................................... 97
Analysis ................................................................................................................................................................. 98
Exporting the raw data .......................................................................................................................................... 99
Producing a standard report ................................................................................................................................... 102
Analysing individual questions .............................................................................................................................. 108
Example reports ................................................................................................................................................... 111
EDGE add-ons ...................................................................................................................................................... 115
Panel Management ................................................................................................................................................ 115
**What is an e-Dialogue?**

An e-Dialogue is an on-line programme that a participant interacts with via a web-browser over the Internet or on an internal Intranet. An e-Dialogue can take the form of a survey, an e-learning module or a test.

An e-Dialogue can be created directly on-line via a web browser, or more usually off-line using the e-Dialogue Generator – EDG installed on a PC or Notebook.

Once an e-Dialogue is created, it is made available to a set of participants using the Dialogue Management System – DMS, which considerably reduces the cost and administrative overhead of delivery, tracking, reminding and reporting.

**e-Dialogues for surveys**

Surveys can be created that range from the simple to the very sophisticated, incorporating complex conditional branching, piping (passing responses from one question to another), randomisation of options and extensive use of graphics to represent choices. A very wide range of question styles are available that include engaging sliding scales, ranking on single screen and alpha/numeric input with validation.

**e-Dialogues for e-learning**

Using the e-Dialogues Generator, on-line, engaging e-learning modules can be generated at a speed never before possible by internal staff without specialised skills. Many different types of interactivity can be included to hold the participants’ interest and focus attention.

**e-Dialogues for testing knowledge**

Using the score recording capabilities, an e-Dialogue can be created to test a participants knowledge of a subject, ideal when a measure level of certification is required. Each question page can be set to time-out to force the pace of response.

**e-Dialogues Generator - EDG**

Using EDG, an Author can create e-Dialogues without the need to be connected to a network. Drag-and-drop techniques create an intuitive interface and all e-Dialogue applications can be shared and reused by authors to reduce duplication.

**Dialogue Management System - DMS**

DMS automates the process of tracking who has done what and when, reminding those who have not completed in a given timescale and providing a comprehensive usage report. It can also be used to track usage and seek feedback on any materials delivered electronically such as Word documents, PowerPoint presentations, pdf files, etc.

**System Requirements**

The e-Dialogue Generator runs under the Windows 95 or higher operating system. (This includes Windows 95/98/ME, NT 3.51/4.0/2000/XP/Vista).

A Pentium II 133HMz or higher processor is recommended.

It requires a minimum of 20MB hard disk space to install and it’s recommended to have 50MB free to build multiple e-Dialogues.

The program does not require any extra memory requirements, but it’s recommended to have at least 32MB of RAM.

The screen resolution must be at least 800x600 and more than 256 colours is strongly recommended. (See Windows ‘Control Panel’ – ‘Display’ – ‘Settings’ to adjust these settings)
Installation

First Time Installation

The e-Dialogue Generator - EDG is a software application that runs on an individual PC. Each copy of the EDG is unique to the PC on which it is installed. Your internal IT Department will normally conduct this installation process.

1. Run the downloaded ‘EDGInstall.exe’ file to start the installation, as shown in Figure 1.

   Figure 1

2. Click Next

   Figure 2

3. Accept or change the location to install the EDG program and support files.

4. To change the default install folder, click the Browse button and select the required folder, as shown in Figure 2.

5. Click Next
6. The setup program will add icons to a folder called **Interactive Dialogues**, as shown in Figure 3, you can change this name if you wish, else click **Next** to continue.

7. Click **Finish** to start installing the EDG files to your hard disk, as shown in Figure 4.
8. After a successful installation, you can get the setup program to automatically launch the installed program after pressing the **Finish** button. If you don’t want this, un-check the **Run the installed application now** option, as shown in Figure 6.

### Figure 7

**Interactive Dialogues**

<table>
<thead>
<tr>
<th>Name</th>
<th>Size</th>
<th>Type</th>
<th>Modified</th>
</tr>
</thead>
<tbody>
<tr>
<td>e-Dialogue Generator</td>
<td>2 KB</td>
<td>Shortcut</td>
<td>16/02/2005 11:33</td>
</tr>
<tr>
<td>Interactive Dialogs</td>
<td>2 KB</td>
<td>Shortcut</td>
<td>25/06/2004 12:27</td>
</tr>
<tr>
<td>Release Notes</td>
<td>1 KB</td>
<td>Shortcut</td>
<td>25/06/2004 12:27</td>
</tr>
<tr>
<td>Uninstall EDG</td>
<td>2 KB</td>
<td>Shortcut</td>
<td>10/02/2005 13:02</td>
</tr>
<tr>
<td>Uninstall IDG v5.2</td>
<td>2 KB</td>
<td>Shortcut</td>
<td>25/06/2004 12:27</td>
</tr>
</tbody>
</table>
9. Three icons are created, as shown in Figure 7.
   a. e-Dialogue Generator – Launched the main Generator program
   b. Release Notes – A text file containing the full change history.
   c. Uninstall EDG – this will remove the entire EDG installation.

**Tip:** You may wish to copy the main EDG launch icon onto your desktop. Click the icon with the left mouse button and drag/drop it onto your Windows desktop.

The first time EDG is installed, an ‘Unlock Code’ is required. To obtain your unlock code, you must send the Identity Code displayed when you first launch the Generator to Interactive Dialogues and we will issue you with an Unlock Code (contact support@interactivedialogues.com for your unlock code).

Upon receipt of the Unlock Code via email, highlight the code within the email and copy it to your clipboard (usually Edit / Copy within most email programs). Then return to EDG and click on the Paste button in the Unlock Code dialog box. (Alternatively, the code can be typed in manually).

Click on the Validate button to confirm the Unlock Code. A message will appear if the Code has been entered incorrectly, in which case you will need to re-paste it, or re-type it.

Click Cancel if you wish to quit from this screen without unlocking the software.

**De-installation**

To de-install EDG:

1. Run the Uninstall EDG icon created upon installation. (from the Windows Start menu – Programs – Interactive Dialogues – Uninstall EDG)

**Note:** the EDG Uninstall program can also be started from Control Panel – Add/Remove Programs

![Figure 8](image)

**Figure 8**

2. Click Yes to start de-installing EDG, as shown in Figure 8.

![Figure 9](image)

**Figure 9**
3. Click **Yes** to remove any additional users created files and folders created in the EDG directory.

![Uninstall Application](image)

*Figure 10*

4. If you are transferring a valid EDG license from one machine to another, you will need to send this code, as shown in Figure 10, to Interactive Dialogues. This is proof of de-installation and without it you cannot get a new Unlock Code.

![Uninstall Application](image)

*Figure 11*

**Launching the Software**

Select the Windows **Start** menu followed by ‘Programs’ – ‘Interactive Dialogues’, then select the ‘e-Dialogue Generator’ item or if the icon exists on your desktop, simply double click the icon.

Enter the password “admin” and click on **OK**.

**Keeping the Program Up-to-date**

To setup the Update period and method

We are constantly improving and adding new features to the system and in order for you to gain these benefits you should perform regular updates with our servers.

1. Select the **Tools** menu followed by **Settings**
2. Select the **Updates** tab
3. Select the method of updating you would prefer (default is via the internet)
4. Select the time period between updates
5. Click **OK** to save or **Cancel** to abort the changes

**To Update Now!**

1. Select the **Tools** menu followed by **Check for Updates**
2. Click OK to continue or Cancel to abort the update process
3. If using the direct Internet method then a connection is made to the ID server and the latest installation file is downloaded if available.
4. Once the update file has been downloaded, EDG will close and the update setup program will automatically launch.
Overview of the EDG window

The EDG window is divided into four main areas:

1. The toolbars and drop down menus at the top of the screen
2. The EDG library at the bottom of the screen
3. The EDG build window at the left hand side of the screen
4. The preview window to the right of the screen. This Preview window contains 3 ‘tabbed’ sub-views, Page Preview, DMS and Report Output.

![Diagram of EDG window components]

**Figure 12**

In order to view the e-Dialogue build window, a new e-Dialogue should be created or an existing e-Dialogue re-opened.

**Note:** The preview window is used to view the e-Dialogue during development, the on-line DMS system and the report output.
Creating a new e-Dialogue

To create a new e-Dialogue click on the icon or select File and then New. A new ‘building...’ window should appear ready to add your pages and items.

Note: A display will only be shown in the Page Preview window when a page with a component is added to the structure.

Opening an existing e-Dialogue

To open an existing e-Dialogue click on the icon or select File and then Open.... A pop up window should appear similar to that shown in Figure 13.

Select the e-Dialogue that is to be opened and then click on Open.

Figure 13

A build window should then appear on the left hand side of the screen as shown in Figure 14.

Figure 14

Tip: It is recommend to re-size and re-position the ‘Building...’ window to fit the area to the left of the Preview Window. This provides easy access to the scroll bars when dealing with multiple pages and items.

Note: An e-Dialogue export file sent from another user via e-mail has a .zip file extension, and is not opened in the same way as a saved and reopened .EDG file. File > Import from file should be used for opening .zip exports.
Saving an e-Dialogue

To save an e-Dialogue click on the icon or select File and then Save. The first time this is done a pop up window, as shown in Figure 15, should appear prompting for a file name. Give the e-Dialogue a filename and click on Save.

![Figure 15](image)

Note: If you have just created a new e-Dialogue that has not yet been saved, then you will be asked to save it when you perform certain actions (e.g. Previewing or Exporting).

Saving with a new name

To save an e-Dialogue with a new name select File and then Save As.... A pop up window (similar to Figure 15) will then prompt for a new name. Give the e-Dialogue a new filename and then click Save.
Adding, Moving and Deleting Pages

Pages are added to the build structure by using the **Insert New Page** icon as shown in Figure 16 or by selecting the **Insert** menu and then **New Page**.

![Figure 16](image)

Each new page will have the default name `<New Page>` and will be inserted at the end of the structure.

To delete a page, select the page by left clicking on it in the structure and pressing the **Delete** key or by selecting the **Edit** menu then **Delete**.

**Note**: If a page title has arrow brackets around it then it will not be shown on the page. It is good practice to title each page (in arrow brackets if the title is not to be shown) in order to avoid mistakes when setting conditional branching.

To move a page to a new position within the structure, click and hold the left mouse button on the page to move and drag it to the new position. A red ‘insert’ marker will show you exactly where the page will be placed in the structure.

For example, if four pages were added to a new structure and given the names Page 1 to Page 4, Click and hold the left mouse button on Page 4 and move it so our mouse is over Page 2 then release would result in the structure shown in Figure 17.

![Figure 17](image)

Adding, Moving and Deleting Components on a Page

To add a component to a page you must first select the Page. Then click the associated component button from the tool bar or select the **Insert** menu and then the component name to add it to the selected page.

![Figure 18](image)

Each new component added to a page is given a default label ‘No Instructional Text’. This text will remain until you enter some question text for that component.

To delete a component, select it by left clicking on it in the structure and pressing the **Delete** key or by selecting the **Edit** menu then **Delete**.

To move a component to a new position within the page or to another page, click and hold the left mouse button on the component and drag it to the new position. A red ‘insert’ marker will show you exactly where the component will be placed in the structure.
You can also Copy/Move Pages or components from one e-Dialogue to another e-Dialogue. Open a second e-Dialogue within the e-Dialogue Generator and copy/move pages/components between them.

Components or entire pages can be **copied** or **cut** to the Windows clipboard ready to be **pasted** into a new location or another e-Dialogue. Highlight the Page or component and either press ‘Ctrl+C’ to copy or ‘Ctrl+X’ to cut. Then highlight the new location and press ‘Ctrl+V’ to paste.

To edit the properties of a component, either **double-click** the left mouse button on the item in the structure or highlight the item and select the **Edit** menu and then **Properties**.

**Note:** If you press and hold the **Ctrl** key whilst dragging a page or component, the cursor changes to show a small ‘+’ symbol. If you then release the left mouse button with the Ctrl key still pressed, then the Page or component is **copied** not moved to the new location.
General Text Editing Functions

When editing text in the Question Text tab of any component, you can right-click the mouse to display a pop-up menu giving you access to various editing features (e.g. Font size, colour, bold flashing etc).

Tip: Because e-dialogue pages are built using standard HTML, you can insert HTML tags to customise the text. Details on the HTML specification is beyond the scope of this manual.

1. **Cut, Copy, Paste, Undo and Redo**: Standard Windows clipboard editing functions.
2. **Bold**: Inserts bold tags around the selected word or paragraph (<B>text</B>).
3. **Italic**: Inserts italic tags around the selected word or paragraph (<I>text</I>).
4. **Underline**: Inserts underline tags around the selected word or paragraph (<U>text</U>).
5. **Size**: Select the new font size in pixels for the selected words (<size=14>text</size>)
6. **Colour**: Change the text colour of the selected word/s (<c=red>text</c> or <c=#FE12A4>text</c>). Select *Custom Colour…* to specify a colour to the RGB level.
7. **Centre**: Centres the text on the screen
8. **Flash**: Inserts special ‘Flash’ tags around the selected words
   a. `<f>text</f>` - Flash the text continuously
   b. `<f=2>Text</f>`  - Start flashing after 2 second
   c. `<f=2,3>Text</f>`  - Start flashing after 2 second and stop flashing after another 3 second
9. **Bullet List**: Turns the selected lines into bulleted lists on the page
10. **Numbered List**: Turns the selected lines into an ordered number lists on the page
11. **Hyperlink**: Turns the selected words into a clickable ‘hyper link’ that when pressed shows a popup window containing the web page specified.
12. **Insert Popup Tip Text**: adds a pop up box that appears when the user moves the cursor over the original text.
13. **Insert Image**: adds an image from the library within the text.
14. **Questions Right**: Inserts a special ‘Tag’ to display the number of questions the users has answered correctly ([Correct] – do not edit this tag)
15. **Questions Answered**: Inserts a special ‘Tag’ to display the number of questions the users has attempted. ([Answered] – do not edit this tag)
16. **Total No. Questions**: Inserts a special ‘Tag’ to display the total number of number of questions in the e-Dialogue. ([Answered] – do not edit this tag)
17. **Percentage Score**: Inserts a special ‘Tag’ to display the users score as a percentage. ([Score%] – do not edit this tag)
18. **Add Text to Library**: This will add the selected text to the Question text library. This text can then be re-inserted at any time in the future.

---

**Figure 19**

- Cut, Copy, Paste, Undo and Redo
- Bold
- Italic
- Underline
- Size
- Colour
- Centre
- Flash
- Numbered List
- Hyperlink
- Insert Popup Tip Text
- Insert Image
- Insert Questions Right
- Insert Questions Answered
- Insert Total No. Questions
- Insert Percentage Score
- Add Text to Library
**WYSIWYG Editor**

With version 3.0 and above of EDG, you can enable the WYSIWYG (what you see is what you get) editor. This allows you to edit and format the text using simple word processor functions.

To enable this editor, select ‘Tools’ – ‘Enable Advanced Editor’

When WYSIWYG is activated, the following window is shown when editing the question text tab of a component.

**Note:** This WYSIWYG editor is only available when editing Question Text, and is unavailable for editing option or answer text.

![Figure 20](image)

**Using Native HTML**

By default, using native HTML results in additional carriage returns being shown on the ed page due to post-processing of the question text. To avoid this, all carriage returns should be removed and replaced with `<br>` tags. This can result in the block of HTML being more difficult to read.

**e.g.**

This is a table
```
<table width=50% border=1><tr><td width=50%>1</td><td>2</td></tr><tr><td>3</td><td>4</td></tr><tr><td>5</td><td>6</td></tr></table>
```

That was a table

By ticking the **Use native HTML** tick box, post processing is eliminated and the question text is treated as native HTML. This allows HTML to be formatted in a more readable way.

**e.g.**

This is a table
```
<table width=50% border=1>
<tr><td width=50%>1</td><td>2</td></tr>
<tr><td>3</td><td>4</td></tr>
<tr><td>5</td><td>6</td></tr>
</table>
```

That was a table
Figure 21

Use standard question text: [ ] Use native HTML [ ]

Place this question on: on a new line

Figure 22

Figure 22 shows how the question text in Figure 21 looks in the preview window when Use Native HTML is ticked and not ticked respectively. Notice the extra lines between the text and table in the first instance. This is because Native HTML is not ticked and the question text is spaced out in a readable way. To remove the line spaces tick the option Use Native HTML.
Setting the e-Dialogue properties

Properties that are common for the whole e-Dialogue such as question text colour, theme and window size can be set using the e-Dialogues Properties.

These can be accessed by double clicking on the e-Dialogue name in the build window or by selecting Edit and then Properties.

The e-Dialogue properties are split up into four main sections.

The General tab settings are shown in Figure 23. Under this tab the e-Dialogue is given a name, description and pop up window co-ordinates.

The pop up window can be set to appear anywhere on the screen and be any size within the limits of screen size and resolution.

Contents page: The author has the option of being able to activate each page title in the contents window and use it as a link to that page. This feature can be used as a navigation tool.

Figure 23

Tip: When setting the window width and height greater than the default settings, check that the target audience have screen resolutions set sufficiently high to be able to see the whole ED window.
Setting the Look & Feel

The Look & Feel tab, as shown in Figure 24, is where the author chooses how the e-Dialogue will appear to the user.

All settings from this tab are applied to all pages in the e-Dialogue unless they are overridden by using the individual page settings.

The following options are available under this tab.

- **Theme**: EDG contains about 25 themes (including Arabic RTL) for the author to choose from and if selected, will set the header, centre and footer to the predefined style.

- **Item**: All items can be customised including question text, option text, page count and button images etc. Select the item to customize from the drop down list and then change the settings using the control to the right. (e.g. Font, size, style colour etc.) You can also change the background to the header, centre and footer areas on the page. This includes changing the background colour or adding your own image that can also be positioned relative to the page.

- **Header area**: The author has the option to use a page count, a progress bar or no progress indication.

- **Footer area**: The author has the option to hide/show the Menu, Back, Contents, Quit and Finish buttons as well as define the menu page that the user will jump to if they press the Menu button. You can also set a default timeout that will be applied to all pages.

- **Centre area**: The ED can be laid out with each page set-up into one column or divided into up to five columns, each having a width that is fixed or dynamic. This allows the author more flexibility to position the components on a page. To set the page layout select either **one, two, three, four or five columns** from the **Page layout** drop down list. Then choose **Variable** or **Fixed** width for each column. If a column is set to be fixed width then the width in pixels should be entered in the box that appears when fixed width is chosen, See Figure 25.
Variable width columns can be used either side a fixed width column to permanently fix the central column width. If the user changes the width of the display window then the two variable columns will change leaving the central column a fixed width.
Specific Items – using images for ticks

Some of the items under the Customize > Item: drop down list allow images to be used on the pages rather than text. These include buttons and ticks.

By default single/multiple choice questions use a small green tick that either covers a circle or square when selected. Images from the library can be used to represent both the ticked and un-ticked single and multiple-choice selections. Additional images can also be set for mouse over and mouse click which add additional interactivity.

Select the item Option text from the customize item drop down list under the Look & Feel as shown in Figure 26. Click on the button next to the Use image for drop down list and select an image from the library.

![Figure 26](image)

Figure 26 shows images used as ticks for a single choice question.

![Figure 27](image)

Figure 27
Specific Items – using images as buttons

By default, buttons are standard HTML code that automatically expands to match the size of text inside. Alternatively, images from the library can be used to represent any of the buttons.

Select the item **Buttons** from the **Customize** item drop down list under the **Look & Feel** as shown in Figure 26. Select the button from the drop down list box and then choose the button state that the image should be applied to. Up to three images can be applied to each button for when the cursor is either, off, on or clicking the button.

Once images have been selected for all buttons in use, the footer bar should look similar to Figure 29.
**Specific Items – customising the header / footer**

By default, the header and footer areas are 40px high and the left and right margins are 5px. These values can be changed by editing the **Header area** item in the **Look and Feel** as shown in Figure 30.

![Figure 30](image)

A positive or negative offset can also be specified from the centre of the header or footer that allows exact and independent placement of the title text, progress indicator and the navigation buttons.

It is also possible to change the background image or set a background colour by using the options under the **Customise** section.

**Note:** To perform these changes to the footer area select the **Footer area** tab.
Customising text
Special text throughout the e-Dialogue, such as on the buttons and warning messages can be customised using the Customise Text tab as shown in Figure 31.

The text to be changed is selected from the list box and then the replacement text is entered into the New text: box below.

Profiles
The e-Dialogue properties (Look and Feel, Customise Text etc.) can be saved and used again in other e-Dialogues.

Click on the Add New button and then give the profile a name.

If you wish to apply an existing Profile to a new e-Dialogue selected the profile from the list and then click the Restore button.

If you make changes to an e-Dialogues profile and you want to save these changes and overwrite an existing profile, select the profile name and press the Update button.
Settings

It is important to configure your copy of EDG to connect to DMS, receive updates and control file locations etc. To access the Settings select the Tools menu then Settings.

DMS Setup

If you wish to connect directly to your Dialogue Management System (DMS) site, then you must enter the correct details into this dialog box.

1. **User Name:** Enter the username used to logon to your DMS home page
2. **Password:** Enter the password used to logon to your DMS home page
3. **Short Name:** This is your company ‘Short Name’
4. **DMS URL:** This is the full URL web address of the DMS.
   (Unless you have an internal DMS installation or you have a dedicated externally hosted server, then this is normally [http://www.idauser.com/ida_db/](http://www.idauser.com/ida_db/)).
5. **Test Internet Connection:** This can be used to test the connection between EDG and the dms server.

![Settings Dialog Box](image)

**Figure 33**

When you click **OK**, the Page Preview window will switch to the DMS tab and attempt to log you onto your DMS home page. If you don’t see your home page it is usually because the DMS settings are incorrect.
**Updates**

Interactive Dialogues regularly makes improvements, enhancements and modifications to the EDG software and these are free to download. Updates are requested directly over the internet and the updated installation file is downloaded and installed.

Select the **Updates** tab, Figure 34, under **Settings** and set how often you would like to check for updates.

![Settings window](image)

**Figure 34**

*Note:* Your IT department may disable this feature due to internal software installation policy restrictions.
File Locations

The locations where images, default files and EDG files are stored can be edited using the File Locations tab under Settings, see Figure 35.

**Figure 35**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EDG Files:</td>
<td>This is the location where all the EDG files and export files will be created.</td>
</tr>
<tr>
<td>NICE (EDR) Files:</td>
<td>This is the location to place edr files from offline releases.</td>
</tr>
<tr>
<td>System Folder:</td>
<td>This is the location where all temporary working files and library images etc are stored. If you have restricted access to the location where EDG is installed, then your IT administrator must set a folder that you have full access to.</td>
</tr>
<tr>
<td>Use ‘My Documents’</td>
<td>This solves any restriction problems as the EDG Files and System Folders set to use your normal ‘My Documents’ folder (VISTA users only).</td>
</tr>
<tr>
<td>Images</td>
<td>This is the default folder that will be opened when selecting images.</td>
</tr>
<tr>
<td>Image Editor</td>
<td>The image editing package used to edit images directly from the library.</td>
</tr>
</tbody>
</table>
Proxy Server

If connection to the internet is via a proxy server then the details should be added under the **Proxy Server** tab. For more details on this and to see if it is necessary you should contact your IT department.

![Figure 36](image)

**Password Manager**

System entry level passwords can be added, deleted or edited by using the **Password Manager** tab under the Settings as shown in Figure 37.

![Figure 37](image)

**Note:** Password Manager is only available when logged on as an administrator.
Adding components to a page

Each page in an e-Dialogue is built up from components, (e.g. text, images, video, questions, etc.). There is no limit to the number of components that can be placed on a page but it is good general practice to avoid the use of scrolling either horizontally or vertically.

There are twelve components that can be placed on a page:

- Text / Image
- Video / Audio
- Menu
- Single / Multiple choice
- Single / Multiple choice Matrix
- Data Entry with validation
- Sliding Scale
- Ranking
- Budget Allocation
- Drag/Drop
- Pause
- Action item (Email or function)

Text / Images

To add a Text / Image component, select either the page or an existing component then click on the icon on the toolbar or select the Insert menu and then Text Item.

To edit the properties of the text component double click on it or click on it once and select Edit and then Properties. This will bring up the Page Item Properties box as shown in Figure 38.

![Page Item Properties](image)

Figure 38

Enter the text to be added to the page. Text from the Question Text library can be inserted at any point by selecting it from the drop-down list ‘Use standard question text’. You can also insert answers from previous questions (See section on Piping)
The **Image** tab, shown in Figure 39, is where an image can be selected from the library and positioned relative to the text and also page using the **Image position** and **Alignment** drop down lists respectively.

![Image Tab](image.png)

**Figure 39**

**Note:** By clicking the **Apply** button at any time, you can see how the component looks in the **Page Preview** window without closing the components property page.

Once the text and/or image has been selected, click **OK** to save the changes and the current page is redrawn in the preview window to reflect the changes. (See Figure 40)

![Page Preview](page_preview.png)

**Figure 40**
Images can also be added in the middle of the text block by right clicking on the point of insert and selecting **Insert Image**. The image library is then displayed and an image should be selected. When OK is clicked a tag is inserted into the text where the image will go, as shown in Figure 41.

![Page Item Properties](image)

**Figure 41**

The image is shown in the text at the exact point where the piping tag is inserted as shown in Figure 42.

![Image](image)

**Figure 42**

**Note:** Images can also be used as question options replacing text. This offers the option of presenting text and/or images to the user as an option to any question.
Video / Media

To add a Video / Audio component to a page click on the icon on the toolbar or select Insert and then Media Item.

**Note:** the Media file will only play whilst this page is displayed to the user. As soon as the user moves off the page the media file will stop playing.

To edit the properties of the media component double click on it or click on it once and select Edit and then Properties. This will bring up the Page Item Properties box as shown in Figure 43.

**Question Text** tab: Enter any text you want to add to the page associated with this component (See Figure 38).

**Video/Audio** tab, shown in Figure 43, is where a video or audio file is selected from the library and is positioned relative to the text and page using the Position and Alignment drop down lists.

A media file can be either selected from the Media library or referenced by a full URL to the media source.

![Page Item Properties](image)

**Figure 43**

**Media file Options:**

**Position:** Select the position to show the media file relative to the text.

**Alignment:** Select the alignment of the media clip (Left, Centred, Right)

**Width:** The width of the media playback area in pixels. Leave blank to use the default width

**Height:** The height in pixels of the media playback area. Leave blank to use the default height

**Auto Play:** Tick this option to automatically start the media file playing when the page first show

**Show Controls:** Tick this option to display simple Stop/Play/Pause controls.

**Loop Playback:** This option is used to repeat the media file continuously until the next page is displayed.
**Menus**

A menu component is a button or set of buttons, images or hyperlinks that when clicked, perform an action such as branch to another page in the e-Dialogue.

To add a Menu component to a page click on the icon on the toolbar or select Insert and then **Menu Item**. **Question Text** tab: Enter any text you want to add to the page associated with this component (See Figure 38 on page 29)

**Menu Options** tab as shown in Figure 44, is used to specify how many menu items make up the component and what action they perform when clicked.

1. First select the type of **Menu Item/s** required (buttons, images or hyperlinks) from the drop down list box
2. Click the **button to insert a new menu item.**
3. Enter the Button/Link text that will be displayed to the user
4. Select the **Action** to be performed when the button is pressed (move pages, open link, print, close the ed etc.)
5. Select the **Page to branch to** or enter the **URL** to display if required
6. Repeat to add more menu items.

Press the **button to remove an item from the list and use the **button to re-order the list**

**Randomisation:** Fully randomise, randomly flip or alphabetically sorts the menu items.
**Arrangement:** Arrange the menu items vertically or horizontally on the page
**Alignment:** Align the items left, right or centred on the page
**Menu item size:** Allows specific menu item sizes and spacing distances to be used.

Press **Apply or OK** to preview your items on the page.
**Single / Multiple choice questions**

To add a single / multiple choice component to a page click on the icon on the tool bar or select the **Insert** menu and then **List Item**.

To edit the properties of the Single / Multiple choice component double click on it or click on it once and select **Edit** and then **Properties**. This will bring up the **Page Item Properties** box.

**Question Text** tab: Enter any text you want to add to the page associated with this component (See Figure 38 on page 29)

**List Options** tab, as shown in Figure 46 for single choice and Figure 47 for multiple choice, is used to define the items that make up the component and how they are displayed on the screen.

To create the List component:

- Select the type of **Options** to display (text, Images or piped answers from another question).
- If **Use text** then enter each item on a separated line.
- If **Use Images** then press the and select each image from the image library.
- If **Use answers** then select the Page and then the question from which selected answers will become the options for this questions.
- **Randomisation**: You can fully randomise, randomly flip the order or alphabetically sort the options in the list.
- **Show options as**: Single or Multiple choice; horizontal, vertical or list box.
- **Making a selection is**: optional or compulsory.
- **This is a demographic**: ticked to make the question a demographic. This is used for filtering and cross tabulation when analysing the data.
- **Prompt for free text explanation**: tick this option if you want the last option in the list to become Other. When the user selects this option, an input box is displayed asking the user to enter text.
- **Arrange options into columns**: If there are many options associated with a question, they can be displayed across a number of columns to make better use of the space on the page without scrolling. Enter the number of columns in the space provided to a maximum of 10.

For Multiple Choice questions:

- **Minimum Selections**: Enter the minimum number of selection the user must make before they can continue.
- **Maximum Selections**: Enter the maximum number of selection the user must make before they can continue.
- **Final option acts as ‘None of the above’**: tick this option if you wish all other options to be deselected if the final option is selected (multiple choice only).

![Figure 46](image-url)
Setting a correct score
A correct answer can be assigned to the question by clicking on the **Scoring** tab, as shown in Figure 48.

The correct answer is selected from the **Correct answer** drop-down list of question options.

**Show Correct Answer:** Tick this if it is desired that the correct answer be shown. Once a correct answer is assigned to a question, scoring inserts can be added to subsequent pages to show the correct score.

**Do not add to overall score:** Tick this option if you want to reveal the correct answer, but you do **not** want it to count to the overall score for the e-Dialogue.
Exclude this question from reports: Tick this option if the question should not be shown in the report.

Show text instead of number when exporting answer: Tick this option to show the option text rather than the option number in the export report.

Don’t show empty row data in the report’s graph or table: Tick this option to omit options from the report that do not have any data associated with them. This option is very useful for questions with lots of options where only a few have been selected such as demographics.

Press Apply or OK to preview your items on the page.

Figure 49
Matrix questions

To add a Matrix component to a page click on the 📊 icon on the toolbar or select the Insert menu and then Matrix Item.

To edit the properties of the Single / Multiple choice matrix component double click on it or click on it once and select Edit and then Properties. This will bring up the Page Item Properties box.

Question Text tab: Enter text that guides the user when answering the questions.

Matrix Options tab, as shown in Figure 50 for single choice and Figure 51 for multiple choice, is used to specify how many vertical labels and horizontal options there are in the matrix.

To create the Matrix component:

- Select the type of Vertical Labels (Rows heading) to display (text, Images or piped answers from another question)
- If Use text, then enter each question on a separate line
- If Use Images, then click the 📸 and select each image from the image library.
- If Use answers, then select the page and then the question from where the selected answers will become the questions for this component
- Randomisation: You can fully randomise, randomly flip the order or alphabetically sort the options in the list.
- Select the type of Horizontal Labels (Column Headings) to display (text, Images or piped answers from another question)
- If Use text then enter each option on a separated line
- If Use Images then press the 📸 and select each image from the image library.
- If Use answers then select the page and then the question whose selected answers will become the options for the questions.
- Randomisation: You can fully randomise, randomly flip the order or alphabetically sort the options in the list.
- Show options as: Single or Multiple choice
- Making a selection is: optional or compulsory

For Multiple Choice questions:

- Minimum Selections: Enter the minimum number of selection the user must make before they can continue.
- Maximum Selections: Enter the maximum number of selection the user must make before they can continue.
Figure 51

**Setting a correct score**

A correct answer can be assigned to each question by clicking on the **Scoring** tab.

Figure 52

First select the Sub-question then select the correct answer (single choice) or multiple answers (multiple choice).

**Show Correct Answer**: Tick this if it is required that the correct answer(s) be shown to the user. Once a correct answer is assigned to a question, scoring can be used on subsequent pages to indicate to the user their correct score.

**Do not add to overall score**: Tick this option if you want to reveal the correct answers, but you do **not** want them to count to the overall score for the e-Dialogue.

Press **Apply** or **OK** to preview your items on the page.

Figure 53
Drag/Drop Component

To add a Drag/Drop component to a page click on the icon on the toolbar select the Insert menu and then Drag/Drop Item.

To edit the properties of the Drag/Drop component double click on it or click on it once and select Edit and then Properties. This will bring up the Page Item Properties box.

Question Text tab: Enter any text you want to add to the page associated with this component.

Drag/Drop Options tab, as shown in Figure 54 is used to specify how many vertical Containers and how many Drag Items there are.

To create the Drag/Drop component:

- Select the type of Container Labels to display (text, Images or piped answers from another question)
- If Use text then enter each container text on a separate line
- If Use Images then press the and select each image from the image library.
- If Use answers then select the page and then the question whose selected answers will become the container labels for this component.
- Randomisation: You can fully randomise, randomly flip the order or alphabetically sort the options in the list.
- Select the type of Drag Items to display (text, Images or piped answers from another question)
- If Use text then enter each item on a separated line
- If Use Images then press the and select each image from the image library.
- If Use answers then select the Page and then the question whose selected answers will become the items to drag.
- Randomisation: You can fully randomise, randomly flip the order or alphabetically sort the options in the list.
- Allow multiple Drops: Select this option to allow multiple drag items to be dropped into the same container.
- Container Size: Enter the width and height in pixels of the container boxes. If the height is left blank, the height is automatically calculated based on the height of the container text plus one blank line.
- Minimum Items to match: Enter the minimum number of items the user must match before the user can continue.
- Maximum Items to match: Enter the maximum number of items the user is allowed to match.

![Figure 54]
Setting a correct score
A correct answer can be assigned to each container by clicking on the Scoring tab.

First select the Sub-question then select the correct answer (single choice) or multiple answers (multiple choice).

**Show Correct Answer:** Tick this to show the correct answer(s) to the user. Once a correct answer is assigned to a question, score inserts such as [Correct], can be used on subsequent pages to indicate to the user their correct score.

**Do not add to overall score:** Tick this option if you want to reveal the correct answers but you do not want them to count to the overall score for the e-Dialogue.

Press **Apply** or **OK** to preview your items on the page.
Data entry questions

To add a data entry component to a page click on the icon on the toolbar or select the Insert menu and then Data Entry Item.

To edit the properties of the data entry component double click on it or click on it once and select Edit and then Properties. This will bring up the Page Item Properties box.

Question Text tab: Enter any text you want to add to the page associated with this component (See Figure 38)

Data Entry tab, as shown in Figure 57 is used to specify what type of data is to be entered and how it should be validated.

![Figure 57](image)

To create the Data Entry component:

- Select the Data Entry type from the drop down list
- Enter an optional Prefix label (prompt text that appears before the input box)
- Enter an optional Suffix label (text that appears after the input box)
- For Single Line, Multiple Line, Secret Text and e-mail
- Select the Text box width (small, medium or large)
- Enter the maximum character limit for the input box (valid range: 1 to 1024). Leave blank to use the maximum of 1024.
- For Dates: enter the Minimum and Maximum date range then select the input format for the date (dd/mm/yyyy, US mm/dd/yyyy or yyyy/mm/dd)
- For Choice: enter one option per line. (The maximum size of this field is 1024 characters)
- For Numeric: enter the optional minimum and maximum values the user entry must be between (leave blank for no range validation) then enter the number of decimal places to display the input (Optional)
- For Currency: enter the optional minimum and maximum values the user entry must be between (leave blank for no range validation) then enter the currency symbol (Optional)
- Data entry is: If you select Compulsory, then the user must enter data into the input box before they can move on
**Setting a correct score**

A correct answer can be assigned to the question by clicking on the **Scoring** tab.

Setting the correct score will vary depending on the Data Entry type.

For **Text** input: Select the condition to match (e.g. Equals, Contains, does not contain etc) and then enter the text to compare against.

For **Numeric**, **Currency** or **Date** input: Select the condition to meet (e.g. Equals, greater than, between etc) and then enter the value.

**Show Correct Answer**: Tick this if it is desired that the correct answer(s) be shown to the user. Once a correct answer is assigned to a question, scoring can be used on subsequent pages to indicate to the user their correct answer score.

**Do not add to overall score**: Tick this option if you want to reveal the correct answers, but you do **not** want them to count to the overall score for the e-Dialogue.

Press **Apply** or **OK** to preview your items on the page.

![Figure 58](image_url)
Sliding scale questions

To add a sliding scale component to a page click on the icon on the toolbar or select the Insert menu and then Sliding Scale Item.
To edit the properties of the sliding scale component double click on it or click on it once and select Edit and then Properties. This will bring up the Page Item Properties box.

Question Text tab: Enter any text you want to add to the page associated with this component (See Figure 38)
Sliding Scale tab, as shown in Figure 59 is used to specify what type of slider is to be used and whether it is vertically or horizontally positioned.

![Figure 59](image)

To create the Sliding Scale component:

- Select whether the interaction is Optional or Compulsory
- Select the Scale type (horizontal or vertical with images, text or a scale)
- Enter and Overall label (label to be displayed above the slider)
- Enter the range labels (min, mid, max)

Setting a correct score: The correct answer can be assigned to the question by clicking on the Scoring tab. Select the condition to match (e.g. equals, greater than, between etc) and then enter the value (between 0 and 100)

Show Correct Answer: Tick this if it is desired that the correct answer(s) be shown to the user. Once a correct answer is assigned to a question, scoring can be used on subsequent pages to indicate to the user their correct answer score.

Do not add to overall score: Tick this option if you want to reveal the correct answers, but you do not want them to count to the overall score for the e-Dialogue.

Press Apply or OK to preview your items on the page.

![Figure 60](image)
**Ranking questions**

To add a ranking component to a page click on the icon on the toolbar or select the **Insert** menu and then **Ranking Item**. To edit the properties of the ranking component double click on it or click on it once and select **Edit** and then **Properties**. This will bring up the **Page Item Properties** box.

- **Question Text** tab: Enter any text you want to add to the page associated with this component.

- **Ranking Item** tab, as shown in Figure 61 is used to define the items that comprise the component.

![Figure 61](image)

To create the Ranking component:

- Select the type of **Options** to display (text, Images or piped answers from another question)
- If **Use text** then enter each item on a separated line
- If **Use Images** then press the and select each image from the image library (See Tip: To change the colour of the correct answers change the highlight text under the look and feel.)
• Using images as options
• If Use answers then select the page and then the question whose selected answers will become the options for this question
• Randomisation: You can fully randomise, randomly flip the order or alphabetically sort the options in the list.
• Arrange options into columns: If there are many options then this number can be set to display the options in multiple columns for better page layout.
• Minimum number to rank: least number of options the user must rank
• Maximum number to rank: the maximum number of options the user must rank.

Press Apply or OK to preview your items on the page.

Figure 62
Budget allocation questions

To add a budget allocation component to a page click on the icon on the toolbar or select the Insert menu and then Budget Allocation Item.

To edit the properties of the budget allocation component double click on it or click on it once and select Edit and then Properties. This will bring up the Page Item Properties box.

Question Text tab: Enter any text you want to add to the page associated with this component.

Budget Allocation Item tab, as shown in Figure 63 is used to define the items that comprise the component.

![Figure 63](image)

To create the Budget Allocation component:

- Select what sort of Options to display (text, Images or piped answers from another question)
- If Use text then enter each item on a separated line
- If Use Images then press the and select each image from the image library (See Tip: To change the colour of the correct answers change the highlight text under the look and feel.)
Using images as options on Page 68)

If **Use answers** then select the page and then the question whose selected answers will become the options for this questions.

**Randomisation**: You can fully randomise, randomly flip the order or alphabetically sort the options in the list.

**This interaction is**: optional or compulsory

**Budget**: the amount (an integer) that must be split between the options. If the user fails to allocate this amount, then you will not be able to move on. If this box is empty, then no limit is enforced on the user.

Press **Apply** or **OK** to preview your items on the page.

![Figure 64](image-url)
**Pause**

To add a pause component to a page click on the icon on the toolbar or select the **Insert** menu and then **Pause Item**.

To edit the properties of the pause component double click on it or click on it once and select **Edit** and then **Properties**. This will bring up the **Page Item Properties** box.

The **Pause** tab, as shown in Figure 65 is used to define which action the component will carry out. The author has the option of waiting until the next button is clicked or waiting for a specified time period. A pause component is used to show the next component on the page, as opposed to moving the user to the next page. A pause component followed by another component **MUST** be used after a question component if the correct answer is to be revealed to the user.

![Figure 65](image)

**Figure 65**

Figure 66 shows how a page would first appear to a user and Figure 67 shows how the same page appears after the user clicks on **Next**. This is the same page but an additional second component is displayed after the **Next** button is clicked.

![Figure 66](image)

![Figure 67](image)

**Note**: An important use of a pause component is to reveal correct answers. A page must contain a pause and then an additional component after a question where the answers are to be revealed.
Action

To add an action component to a page click on the icon on the toolbar or select the Insert menu and then Action Item.

To edit the properties of the action component double click on it or click on it once and select Edit and then Properties. This will bring up the Page Item Properties box.

The Server Action tab, as shown in Figure 68 is used to define the action carried out when the item is activated.

The author has the following options when setting up the component:-

1. **Action type**: Send email, Call URL, Run script or Raw JavaScript (Advanced)
2. **Send to**: The email address of the person to send to (can be piped)
3. **Sent from**: The email address of the email sender (can be piped)
4. **Subject**: The email subject text (can be piped)
5. **Message**: The email body text (can be piped)

An action item can be used to send information from the e-Dialogue to a person via email. Answer text can be piped into the email using the normal piping methods.

Alternatively an action item can be used to send information from the e-Dialogue to an LMS system. For more information about this advanced feature contact Interactive Dialogues Technical Support Team.

![Page Item Properties](image)

**Figure 68**

**Note**: An action component does not display anything on the page but is executed when the user reaches the page or leaves the page where it is located.

One of the most powerful features of an action component is when the Action type is set to run script. A box is then displayed that is similar to Figure 69.

To be able to use this feature an author MUST have at least a basic knowledge of software design / development.
It is possible to declare variables, use library functions (see Figure 70) and operators throughout the ED to hold and manipulate values. This makes multiple scoring sections and user entered data manipulation possible.

We recommend that you contact support@interactivedialogues.com if you have specific questions on this feature as a full explanation is beyond the scope of this document.

---

**Note:** This feature is only available when **Advanced Features** are enabled (Tools > Enable Advanced Features).
Question Options

EDG offers the following question options that can be used to construct a wide range of e-Dialogues such as e-learning modules, tests, surveys, market research questionnaires and newsletters:

1. **Conditional branching**: changing the order that the pages are presented to the user based on the answers that are chosen to specific questions.

2. **Random page selection**: randomly jumping to X number of pages out of a pool of Y pages.

3. **Piping**: using the answer/s from one question as text or options in another question.

4. **Tool Tips**: Displaying pop-up text when the cursor is held over an image or text.

5. **Randomisation**: presenting question options to the user in a random order to avoid answer bias.

6. **Scoring**: totalling the correct answers from the user and presenting them as a score.

7. **Revealing correct answers**: revealing the correct answer/s from a question to the user after they have selected their option/s.

8. **Using images as options**: images can be used as options instead of text.

9. **Page positioning**: components can be placed anywhere on a page to make best use of the space provided.

10. **Page options**: certain page settings can be overridden for individual pages.
**Conditional branching**

Conditional branching is used to change the path that the user progresses through the e-Dialogue based on their answers to specific questions.

Pages can be made to only show to users who pick an option and not show to those that don’t.

To set up a conditional branching rule create a page with a question that can be used to determine the next page that the user is taken to as shown in Figure 71.

Double click on the page or single click on the page and select **Edit** and then **Properties** to bring up the Page Properties box as shown in Figure 72.

![Figure 71](image)

**Figure 71**

*Note*: Conditional branching can be used to guide the user through a certain route that is dependent on their demographic information such as country and business unit. The question that determines a branch can be on any previous page.

![Figure 72](image)

**Figure 72**

Click on the **Add Rule…** button to bring up the **Conditional Branch Rule** box as shown in Figure 73. The drop-down boxes are used to set the following:-

1. **On page**: the page where the branching question is located
2. **Question**: the branching question
3. **If user (1)**: selects or doesn’t select (options vary depending on the question type)
4. **If user (2)**: the option from the branching question that must be selected to execute the branch

Once the condition is set, by using the drop down boxes at the top of the screen, the **Add this condition to the rule** button must be clicked on before the destination page is set.
If more than one condition is required then the drop down boxes can be used again to set up the second condition and the **Add this condition to the rule button** clicked on again to add the second condition to the rule. The relationship between the two rules is determined by the drop down box at the top left which can be set to either **and** or **or**.

5. **Then goto** : The destination page when the rule is met.

![Conditional Branch Rule](image)

**Figure 73**

6. Once the rule is complete click on **OK** to go back to the **Conditional Branching Rules** box as shown in Figure 74.

As shown, the rule that has been constructed is now shown in the **Branching rules for this page** box.

Additional rules can be added by clicking on the **Add Rule...** button and repeating the rule set-up process.

When additional rules are added to the page they are added to the rules list as shown in Figure 75. The rules will be executed in the order they appear from top to bottom.

To change the execution order, click on the rule to be moved and then use the up and down arrows to reorder it.

**Note**: There is a finite limit to the amount of conditions that can be part of a rule but it is very unlikely that this would be reached unless very complex rules with conditions based on many questions are used.
If there is a possible outcome where none of the rules are met, a default Next Page can be set at the bottom of the Conditional Branching Rules tab.

**Figure 74**

**Figure 75**
**Conditional item display**

Conditional item display is used to either show or hide a component on a page based on an option chosen on a separate question component on the same page.

Components on a page can be hidden to users that select one option and hidden to users that select another option.

To set up a conditional display rule create a page with a question component that will be used to determine which additional components are shown on the same page. Then add a pause component followed by two additional components, one that will be shown if the user answers correctly and one if incorrectly, as shown in Figure 76.

![Figure 76](image)

Without conditional display set on the two text components, the page would appear as in Figure 77.

![Figure 77](image)

To add conditional display logic to the first text component, double click on the text component to bring up the Page Item Properties box and click on the Conditional display tab as shown in Figure 78.

![Figure 78](image)

Select the question from the **Question** drop down list box and then select the condition that must be met for the item to show. The component will not show if this condition is not met. Once the condition is set click on **Add this condition to the rule**, as shown in Figure 79. Then click OK.

**Note:** there is a finite limit to the amount of conditions that can be part of a rule but it is very unlikely that this would be reached unless very complex rules with conditions based on many questions are used.
Set up the conditional display accordingly for the second text component and the output in each case should be as shown in Figure 80.
**Random page selection**

Random page selection shows the user X number of pages out of a pool of Y pages in a random order. This would normally be used to show 10 test questions from a pool of 30 possible test questions in a random order for example.

To add random page selection to the ED structure, edit the page properties of the page before the random jump should occur, as shown in Figure 81. Tick the **Enable Random Page Selection** tick box at the bottom left and then set the amount of pages to show and the amount of pages that should be classed as the pool to be taken from.

Figure 81

The start page changes to red in the ED structure to indicate that it is the start of a random jump section as shown in Figure 82. Holding the mouse over the red coloured page will give details on the random selection.

Figure 82

**Note:** In this example, one possible page order could be: Start page>3>4>1>End page
**Piping**

Piping takes the selection from one question and displays it as text on a subsequent page.

To show a selection being piped as text in a following question, set up an e-Dialogue with a single choice question on the first page and another single choice question on the second page as shown in Figure 83.

![Figure 83](image)

Open the page 2 Page Item Properties and enter the text that should show before the piped answer, as shown in Figure 84. Click on the Insert a previous answer (piping): button at the top right hand corner of the box.

![Figure 84](image)

Using the Answer Piping box, as shown in Figure 85, select the page and question that the piped text will be taken from.

![Figure 85](image)

An insert, as shown in Figure 86, will be placed into the question text that will be replaced with the previous answer in preview mode.

This insert can be used in both the question text and in the question options as shown in Figure 87.
Preview the e-Dialogue from the first page and select an answer for the first question as shown in Figure 88 then click Next.

**Note:** Answers or text can NOT be piped onto the same page.
The text from the first answer is then shown in every place where an insert was placed in the properties as shown in Figure 89.

Piping can also be used to provide a set of options to a question taken from the selected options from a previous question.

Set up an e-Dialogue with a multiple-choice question on the first page and a single choice question on the second page.

The first question **Page Item properties** should look like Figure 90.

Edit the second question **Page Item Properties** and change the **Options**: drop down box to select **Use answers**, as shown in Figure 91.
Select the first question using the From page and Selected answers from list based questions: to make sure that the answers from the first question are “piped” into the second question.

Preview the e-Dialogue and select some options from the first question as shown in Figure 92.

Click on Next and the selected answers from the previous question are now displayed as question options on the second question, as shown in Figure 93.
**Tool Tips**

Tool tips are used to give the user more information about some text or an image without having to permanently display the text on the page.

Select any text or image insert in an ED and right click to select **Insert popup tip text**. A box appears that asks for text for the tip and a width/height for the popup box as shown in Figure 94.

![Insert Popup Text](image)

**Figure 94**

When the page is previewed and the text hovered over with the cursor, the tip text is shown as in Figure 95.

![Tip Text](image)

**Figure 95**
**Option ordering**

Option ordering is used to display question options in either a random order, a randomly flipped order or alphabetically sorted.

Set up a single-choice question with more than three options and open the **List Options** tab under the **Page Item Properties**. Set the **Option randomisation** tab to **Off**, as shown in Figure 96, and then click **OK**.

Copy the question and paste it three times on the same page. Set up the **Option randomisation** on the other three components to be **Flip order**, **On** and **Sort** respectively.

When the page is previewed it should show the four lists displayed in the four different orders as shown in Figure 97.

**Note**: randomly ordered question options are often used to remove answer bias in market research style questions.

**Note**: Alphabetically sorted options are a very important feature in allowing language choice lists to be displayed in an alphabetical order for all languages without corrupting the data.
Scoring
Scoring is used to keep a running total of a user’s correct answers to questions throughout the e-Dialogue so that they can be displayed, usually after a test.

To demonstrate scoring, set up a single choice question component, such as the one shown in Figure 98.

Enter options for the question and then make it compulsory so that the user is forced to answer, as shown in Figure 99.

![Figure 98](image)

Click on the Scoring tab that is common for all question components and select the correct answer from the drop down list, as shown in Figure 100, then click OK.

**Note:** any question that is given a correct answer is automatically classed as a scoring question unless the option ‘Don’t add to the overall score’ is ticked in the Score tab.

![Figure 99](image)
Copy and paste the question component three times and change the question and answer options so that each question is slightly different as shown in Figure 101. On the following page create a text component and right click to add all the scoring tags as shown in Figure 102.

**Note**: To omit a specific question from the overall score, tick the box marked Do not add to overall score under the scoring tab in the page properties.
Preview the e-Dialogue and answer the questions as shown in Figure 103. The following page should show the score values, as shown in Figure 104.
**Weighted Scores**

Weighted scores are used to make options contribute different amounts to the overall score.

To show a weighted score, click on the Weighting tab of a single-choice question and apply weighting similar to that in Figure 105.

![Figure 105](image)

In this case, if the user selects option 2 then 10 will be added to their weighted score. The weighted score is shown on the page by using the tag [WeightedScore] as shown in Figure 106.

![Figure 106](image)
**Revealing correct answers**

The correct answers to a question can be revealed to the user after they have made their choices and clicked on the **Next** button. They are then unable to change their previous answers.

To show the correct answers open the **Scoring** tab of a question component and tick the **Show the correct answer after the question has been attempted** box, as shown in Figure 107.

![Figure 107](image)

Give correct answers to all the questions in the Scoring example and then add a pause component followed by a text component to the same page.

Preview the e-Dialogue and give answers to all the four questions as shown in Figure 108 and then click **Next**.

The correct answers should then be shown on the same page, as shown in Figure 109.

![Figure 108](image)

**Figure 108**

**Figure 109**

**Tip**: To change the colour of the correct answers change the highlight text under the look and feel.
Using images as options
Images can be used instead of text for both labels and options for any question component. To demonstrate using images, open the question options for any question component and select Use images from the options drop down list, as shown in Figure 110.

![Figure 110](image1.png)

To add image option/labels click on the + button and select an image from the library as shown in Figure 111. The order of the images can be changed by using the up and down arrows next to the + and – signs. Preview the page and the component should look similar to that in Figure 112.

![Figure 111](image2.png)

**Figure 112**
Tip: All images should be sized correctly in an image editor before being added to the image library.
**Positioning components on a page**

To make more efficient use of the space on a page, components can be positioned horizontally relative to the previous component as well as vertically.

By default, all components are positioned vertically below the previous component.

To change the position to horizontal, open the **Question Text** tab under the **Page Item Properties** box, as shown in Figure 113.

Using the **Place this question on** drop down list, select **on the same line as the last question** instead of **on a new line**.

![Figure 113](image)

Figure 113 shows how a page could look if questions are spaced out to make best use of the space available.

**Tip**: It is advisable to avoid placing too many questions on one page as it can make the page look overly cluttered.

![Figure 114](image)

If a whole e-Dialogue or just a single page has been split into 2 columns in the e-Dialogue properties then each component can be placed in the left or the right column. To set which column the component should be placed in, select either **Left** or **Right** in the drop down list box at the bottom of the Question text tab as shown in Figure 113.

Using this method, components can be placed very accurately on the page making it more visually appealing to the user. See Figure 115.
Each page of an e-Dialogue has its own set of properties that can be used to override the default settings from the overall e-Dialogue properties. These can be used to hide buttons, set a different background or time the page out. To access these individual page settings double-click on the page number in the ED structure and the general page properties box is displayed as shown in Figure 116.

![Figure 116](image)

**Note:** Components can be placed on the same line or on a new line within each of the two separate columns.

### Single page options

Each page of an e-Dialogue has its own set of properties that can be used to override the default settings from the overall e-Dialogue properties. These can be used to hide buttons, set a different background or time the page out. To access these individual page settings double-click on the page number in the ED structure and the general page properties box is displayed as shown in Figure 116.

To give the page a timeout, a number must be entered into the **Page timeout** entry box. The e-Dialogue will automatically move onto the next page when the timeout counter counts down to zero in seconds.

The contents page titles can be made to either follow the setting under the Look & Feel tab of the e-Dialogue properties or they can be overridden for an individual page. This is changed in the same way as buttons using the **Contents page links** drop-down list box. Page titles can also be hidden from the contents page by ticking the **Hide this page in ‘Contents’** tick box.

The following pages in the structure can be made to display in a random order by ticking the **Enable Random Page Selection** tick box and then entering in the number of pages to be selected.

Clicking on the Change button under the Look & Feel tab can change the background image of the centre section. After a local image location is selected the image can be positioned horizontally and vertically by using the **Alignment** drop-down list boxes.
To change the layout of the page to differ from the layout of the overall ED select either one to five columns from the **Arrange items into** drop down list box and then decide which column should be dynamic or a fixed width and by how many pixels.

The hide/show button and timeout settings for the whole e-Dialogue can be overridden for any page by changing the settings of the **Look & Feel** tab under the **Page Properties**, as shown in Figure 117.

Each button can be set to be *Hide*, *Show* or *Use default* setting form the e-Dialogue **Look & Feel**.

Figure 117

![Page Properties](image)

Figure 117 shows a page with all the buttons hidden apart from the **Next** button and a 30 second timeout counting down at the bottom right of the window.

Figure 118
Adding languages

Users can be given the option to select the language that is used to display all text in the programme.

To demonstrate adding an additional language, create an e-Dialogue and add a text component as shown in Figure 119.

![Figure 119](image1)

Select Edit and then Languages to bring up the Language Manager box as shown in Figure 120.

![Figure 120](image2)

Type in the name of the second language and then click Add to add it to the Current Languages as shown in Figure 121.

![Figure 121](image3)

The display language can be changed by selecting from the language drop down list. Change the language to the second option as shown in Figure 122.
The original English text can now be replaced by the same text but in the second language as shown in Figure 123.

At any point in time the English version of the e-Dialogue can be accessed by selecting English from the language drop down list, as shown in Figure 124.

**Note**: The default language can be renamed if ENGLISH is not needed.

To copy the language text for a component across all other languages, right click on the component and select the option Equalize text.
Importing/Exporting language text

For translation purposes, all text in an ED can be exported to a text file and a translated text file can be imported back into an ED.

To create a text file for translation select Edit then Export language text.

A box will appear like that in Figure 125 showing a summary of what is contained in the file. After making a note of these values click on the Zip and send by E-mail to create a zip file containing the text file inserted into a new email.

![Figure 125](image)

To import a translated text file select Edit and then Import language text. After selecting the text file, select the language that the text will be imported into, Figure 126, and click Import.

![Figure 126](image)

You can verify that the language has been imported correctly by selecting the 2\textsuperscript{nd} language from the main drop down list and previewing a page.

Export Text for Review

Text for the whole ED can be exported to rtf without tags for review.

This can be done by selecting Edit and then Export text for review.

It is important to note that this text is for review purposes only and cannot be imported back into the ED with changes. This feature is useful for doing a final review in conjunction with the word feature “track changes”.

---

Page 75
Advanced Features
EDG has a growing list of features that could be seen as confusing for first-time authors.

These features are often very powerful and necessary for the advanced author to create advanced learning or testing modules.

In order to keep the program simple to the majority of authors the advanced features are not displayed by default but can be activated by ticking the Enable Advanced Features option in the Tools menu, see Figure 127.

Figure 127

Enabling the advanced features gives the author access to the following features:-

- Action components that can be used for scripting
- Conditional branching based on variables
- Default and hide settings for the majority of questions
- Auto-registration settings

Scripting
The action item can be used to execute a script consisting of variables operators and functions. In general, variables are declared at the start of the ED and then they are used in functions with operators on subsequent pages.

A variable can be either a numeric, string or a date type and is declared in the following way:-

\[
\text{Declare}(\text{"var1"}, \text{"String Variable"}) \quad \text{- string} \\
\text{Declare}(\text{"var2"}, 9999) \quad \text{- numeric} \\
\text{Declare}(\text{"var3"}, \text{"12 August 2012"}) \quad \text{- date}
\]

In this case \text{var1}, \text{var2} and \text{var3} are the names of the variables with String Variable, 9999 and 12 August 2012 the initial values assigned to them respectively.

Once the variables are declared and given initial values they can be displayed or used in functions.

To display a variable, the following insert can be used at any point in the ED:

\([\text{var:var1}]\) where \text{var1} is the variable name that was previously declared.

In this case a text component with the text \text{[var:var1][var:var2][var:var3]} would give the following output at run time.

String Variable 9999 12 Aug 2012

To assign a new value to a variable, a script is used similar to the one in Figure 128.
In this case, the value of the number of correct answers, [Score] is assigned to the variable temp1.

The function NUMTOTEXT is used to change the numeric temp1 variable into a string variable, add the text " / 9" after it, and then assign it to the string variable var1.

The run time output when using [var:var1] would be "8 / 9" if the user scored 8 correct answers out of 9.

By clicking on the Insert… button a list of functions, operators and variables are displayed like that in Figure 129.

Note: It is beyond the scope of this document to describe each of the scripting functions available to the author. Please contact support@interactivedialogues.com if you have specific questions.
**Conditional branching based on variables**

It can be required to branch to a page based on the value of a variable. For instance, if a user achieved a pass score they should be branched to a “pass” page but if they failed they should be branched to a “fail” page. This is only achievable if the conditional branch is based on the score value.

To set up a conditional branch in this way edit the conditional branch rules of the branch page and enter a rule similar to the one in Figure 130.

In this case if the user scored more than 8 they would be taken to the pass page.

Conditions can be linked using AND or OR operators in the same way as normal conditional branches.

![Figure 130](image)

**Default and Hide settings**

All question components can have a default value and/or can be hidden completely from the user. Figure 131 shows a single choice component with a default value of 1 i.e. the 1st option is ticked by default. When the user reaches this question they will see the first option as selected.

This is a useful feature for opinion based questions where the default value can be set as neutral such as the centre position for a slider from bad to good.

A more advanced use of this feature is to set the hidden demographics of a survey as the extra user data fields from the user record in DMS. This enables branching and reporting based on these predefined demographics.

This is very useful when users are asked to go through a series of e-Dialogues and it is preferred not to repeat the same demographic questions in each ED. As well as being a monotonous exercise for the user a single mistake can distort the results.

![Figure 131](image)
Auto-registration

This feature connects EDG to DMS and enables an anonymously scheduled ED to capture a user’s basic information and automatically create a user record in DMS.

Auto-registration could be used in a situation where the identities of the target users are unknown but in the future you wish to schedule additional EDs to the users that have provided their details.

To enable auto-registration for an ED add an additional first page with the following data entry components at the beginning:

<table>
<thead>
<tr>
<th>Component</th>
<th>User field mapped to in DMS</th>
<th>Optional / Compulsory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single line / choice TITLE</td>
<td>Title</td>
<td>Optional</td>
</tr>
<tr>
<td>Single line FIRSTNAME / SURNAME</td>
<td>Firstname / Surname</td>
<td>Optional</td>
</tr>
<tr>
<td>Single line USERNAME</td>
<td>Username</td>
<td>Optional</td>
</tr>
<tr>
<td>Email address EMAIL / verification</td>
<td>Email / verification</td>
<td>Compulsory</td>
</tr>
<tr>
<td>Secret text PASSWORD / verification</td>
<td>Password / verification</td>
<td>Compulsory</td>
</tr>
<tr>
<td>Single line / choice Extra User data 1-10</td>
<td>Extra User data 1-10</td>
<td>Optional</td>
</tr>
</tbody>
</table>

When setting up a component, see Figure 132, the box Used for Auto-registration should be ticked and the Map to user field should be set to the correct field for the user.

Figure 132

Once set-up, the page components should look similar to that shown in Figure 133 and be displayed similar to that shown in Figure 134.

Figure 133
When designing an ED with auto-registration there are a number of rules to follow:

1. The minimum two fields of information that have to be collected from the user are email and password. In this situation the name and username will both take on the same value as the email.
2. The auto-registration page must be at the beginning of the ED, before any other data is collected. When a user completes this page they are changed from being “anonymous” to “known” as soon as they click the next button. If the email address is already in the system then the password is checked. If this is correct then they progress through the ED as the known user. If this is incorrect then they are alerted and not allowed to continue. If the email address is not in the system then the user is then added.
3. An auto-registration page can be used to display known users’ information, including demographics held in User1 – User10. The mail merge value of the DMS user field should be entered into the default value for the component, as shown in Figure 135. If demographic information is stored in User1-10 then the user can verify it is correct without having to select it again every time they run through an ED. An added benefit of this is that demographic filtering can be applied in the report.
4. When using Extra user data 1-10 as saved demographics it is advisable to use the choice component rather than the single line text entry in order to make sure the user selects a known option. If all users are allowed to enter plain text then it is more difficult to group users together as demographics can be spelt incorrectly.

Display Effects

By default, all components appear in their predefined positions when the page is displayed or after the next button is clicked if they follow a pause component. Display effects can be applied to components that change the way the component is displayed and the location it is displayed in.

To apply display effects to a component, edit the component properties and click on the Display Effects tab as shown in Figure 136.

The following effects are available:

1. Effect: No Effect or Fade up
2. Speed: The time it takes for the component to be 100% displayed
3. Horizontal offset: The horizontal distance between the original and transition starting points.
4. Vertical offset: The vertical distance between the original and transition starting points.
5. Specific positioning: The distance in pixels from the top left of the page where the component is displayed.

Clicking the Preview button shows a simulation of how text appears with the current settings.
Display effects can be applied to a component, a page or the whole ED. To apply the effects to a page, edit the page properties and click on the Display Effects tab, as shown in Figure 137.

To apply the effects to all pages in an ED, right click on the top level ED name and select **Apply Display Effects.**
Tools

EDG contains the following tools to manage, validate and help in the creation of new e-Dialogues:

- **Library**: stores images, media, question text and option text.
- **Spell checker**: validates the spelling for the entire e-Dialogue.
- **Search / Replace**: customise existing e-Dialogues by doing bulk text changes.
- **Validation**: toggle the logic settings.
- **Validate**: Check the logic throughout the whole e-Dialogue.
- **Advanced Editor**: Enable the advanced WYSIWYG editor.
- **Page Capture**: Capture the screens for review purposes.

The library

The library stores all images and media files but can also be used to store commonly used question and option text.

To access the library click on the icon on the toolbar or select Tools and then Library.

To view images in the library select the Images tab as shown in Figure 138. A list of library images is shown on the left hand side and a preview of the image is shown on the right hand side when it is selected.

To add a new image click on the New button to display the Image box as shown in Figure 139.

Use the Browse... button to locate an image stored locally and then give it a name using the description box.

If it is intended that other users are able to access the image from the library once it is uploaded to the DMS site then un-tick the No one else can use this image tick box at the bottom left hand corner.

To add a set of images click on the Insert button and select the set of images to be inserted into the library. The name of each image in the library will be the same as the file name including the extension.
To view media files in the library select the **Media** tab as shown in Figure 140.

A list of media is shown on the left hand side and a preview of the media is shown on the right hand side when it is selected.

New media is added in the same way as images.

**Note**: If an image is uploaded with the **No one else can use this image** box ticked then no one else will see the image in their library.

To view question text in the library, select the **Questions** tab as shown in Figure 141. Lists of question text are displayed with search capability using the **Filter** box.
To view option text in the library select the **Options** tab as shown in Figure 142. Lists of options are displayed with search capability using the **Search** box.

![Figure 141](image1)

**Figure 141**

To export part of the library click on the **Export** button at the bottom left of the library window and a window similar to Figure 143 will appear. Select the items to include in the export and click **OK**. Similarly, to import another user's library click on **Import** at the bottom left of the library window and select the file to import.

![Figure 142](image2)

**Figure 142**

**Tip:** HTML code can be stored as question text for copyright banners or tables.

Part or all of the library can be exported to another user via a zip file. When the zip file is imported the library will be updated with the new imported components.
To edit an image directly in the library, select the image in the list and click **Edit**. A box similar to that shown in Figure 144 should be shown. Click on the **Edit** button and the default image editing software (as set in Tools > Settings > File locations) will open the image to edit.

Make any alterations, save the image then click OK in the library. The edited image will be shown when the page is next previewed.

**Note**: When editing an image directly in the library, the original image is permanently edited and no additional versions are created.
The Spell Checker

The spell checker can be used to check all text in an e-Dialogue against the dictionary.

To access the spell checker click on the icon on the toolbar or select Tools and then Spell checker....

Select a language using the drop down box shown in Figure 145 and then click Start.

Figure 145

When the spell checker finds a character or set of characters that it does not recognise in the dictionary it will display it in a query box as shown in Figure 146. The standard options to ignore or replace exist as well as being able to edit the dictionaries.

Figure 146

Search / Replace

Any set of characters can be searched upon and replaced by another set of characters by using the search and replace option. To open this, click on the Search / Replace icon on the toolbar.

Type the characters that are to be changed into the Find What: box and the new characters in the Replace with: box as shown in Figure 147. If only the first instance is to be changed click on Replace If all instances are to be replaced click on Replace all.
Validate

It is vital to make sure that all conditional branches, language variations and scores are set up correctly before releasing an ED to a user group.

To validate the ED select Tools and then Validate.

If no errors are found a box like that in Figure 148 should be shown.

![Figure 148](image)

If there are errors, a box giving details on each error will be displayed. Double click on an error to go directly to that component in the build window.

Validation is also automatically carried out when exporting.

Validation

It is useful to be able to disable some of the features of an ED while still developing in order to aid the testing process. The validation option allows individual features to be enabled or disabled.

To enable or disable validation options select **Tools** and then **Validation**.

- **Enable Randomised Pages**: Disabling this option allows the author to move through all pages in a random pool
- **Enable Randomised Options**: Disabling this option enables more efficient testing of correct answers when the first option is always made correct and options randomised.
- **Enable Conditional Page Branching**: Disabling this option allows the author to move through each page of the ED in order
- **Enable Conditional Item Display**: Disabling this option shows all items on a page regardless of conditional display settings
- **Enable Compulsory Options**: Disabling this option allows the author to move through each page without having to answer any questions that are normally compulsory
**Changing the display**

The preview and library window can both be made to tile or cascade depending on the preferences of the author.

To change the view options select **Tools** and then **Window** as shown in Figure 149.

![Tools and Window options](image)

**Figure 149**

To reset all window size and positions select **Reset Window Layout**.
Exporting from EDG to DMS

All e-Dialogues can be directly uploaded from the off-line EDG tool to the on-line DMS ready for scheduling.

Before an upload can take place the **Settings** must be correct as shown in Figure 150 and the DMS must be displayed in the main window when the DMS tab is selected, as shown in Figure 151.

Once these settings are correct select **File** and then **Export** to bring up the export window as shown in Figure 152. At this point an export of the e-Dialogue is stored on the local PC at the location specified at the top of the box.

If nothing else is to be done then select **Nothing** from the list and click **Close**.

If the export is to be emailed to another user select **E-mail to another user** and click **Close**.
If the e-Dialogue is to be uploaded to DMS select Upload directly to DMS server from the list. If the e-Dialogue is not detected as existing in DMS then the message This e-Dialogue does NOT exist in the database is displayed and the Create New button should be clicked to start the upload.

If the e-Dialogue is detected in DMS then the message This e-Dialogue DOES exist in the database is displayed and a check as to whether the e-Dialogue is currently scheduled is made.

If the e-Dialogue is not scheduled then the option to Overwrite is displayed. If the e-Dialogue has been scheduled then the Overwrite button is greyed out and only the option to Create New is displayed.

Click on Create New and EDG will upload the e-Dialogue to DMS. Once the upload is complete the e-Dialogue should be visible in the list of e-Dialogues within DMS as shown in Figure 153.

Note: Always check you can view your DMS homepage using the DMS tab before uploading an e-Dialogue to the DMS site. If the homepage is not shown then check the setting on Tools > Settings > DMS Setup.
Open the e-Dialogue within DMS and check that it is the same as in the build window, as shown in Figure 154.

The security settings can only be changed within DMS and not from EDG.
Importing from DMS to EDG

To import an e-Dialogue from DMS to EDG for editing or reporting select **File** and then **Import** to display the **Import e-Dialogue** box as shown in Figure 155.

Select the e-Dialogue from the list and click on **Import**. If there are numerous e-Dialogues on DMS then the dynamic filter can be used. Enter part of the name of the ED and only EDs with that text will appear in the list.

![Image of Import e-Dialogue window]

**Figure 155**

**Note**: the import e-Dialogue window will only display e-Dialogues that you have permission to view.
Importing from DMS Knowledge base

To import an e-Dialogue from the DMS Knowledge base to EDG for review select File and then Import from DMS Knowledge base to display the Import e-Dialogue box as shown in Figure 156.

![Figure 156](image)

Select the e-Dialogue and click Import.

The knowledge base will be updated by Interactive Dialogues periodically.
Creating NICE Files

A Non-install clean executable (NICE) file is an executable (.exe) file that can be generated and sent via email to users who do not have use of the Internet or a very slow internet connection. A user simply double clicks on the file and runs through the e-Dialogue as normal. Upon completion a “.edr” file is generated and sent via email directly back to the author of the ED for reporting purposes. Alternatively, the files can be stored in the same folder on one common PC.

To create a NICE file select **File** and then **Create NICE file**. This will then bring up a box that looks like that in Figure 157.

The features of this box are as follows:-

- All NICE files will be stored in the location specified in the **Save NICE file in** box.
- The name of the .exe file is entered in the **NICE file name** box.
- If it is required that each user should be able to quit the ED at any time and continue later then the **Enable Restore ID** tick box should be ticked.
- If all .edr files should be sent back to the author then the **E-mail user feedback on completion** tick box should be ticked. If the ED is to be run in a kiosk type environment where every user will be using the same machine then this option should not be ticked, as it is required that all .edr files should be stored locally.
- If no feedback from users is required the **For demonstration only** tick box should be ticked.
- If it is known that the user group will be running the NICE file on Windows95/98/ME (non-Unicode supported) then the **Create Non-Unicode version** tick box should be ticked.
- If the NICE file is to be used in a kiosk situation then the **Do not delete temporary files** tick box should be ticked to maximise the NICE file run speed.

To run reports on collected edr files, save all the data files into the location C/Program Files/EDG/EdrData/ or equivalent. When a report is created, this folder is automatically checked and any relevant edr file data is added to the report.
Screen Capture

When multiple authors are involved in creating a large ED it can be beneficial to capture the screens for review. A document, usually word or pdf, can be created with one screen capture per page and an area to input comments.

To open the screen capture feature press F8 and a box should be displayed like that in Figure 158.

![Print Capture](image1)

**Auto capture changed screens**: Tick this option to auto capture the changed screen at predefined set time intervals. Leave this option not ticked to manually capture the screen each time using the F8 key.

**Play Capture sound**: Tick this option to play a capture sound each time the screen is captured.

![Screen Capture](image2)

Run through the ED in preview mode from the point of first capture to the end. If manual capturing is set then F8 should be pressed to capture each screen. Once all the pages have been captured press F9 to finish capturing and automatically export all the screen captures to .rtf format as in Figure 159. The .rtf format document can then easily be saved as .doc format if required.
Creating SCORM Files

If the ED is to be used on a separate Learning Management System (LMS) other than DMS then there is the option to create a SCORM compliant package.

To create a SCORM package select **File** and then **Create SCORM Package**. There is the option to create packages that are either version 1.2 or 2004.

An explanation of SCORM is beyond the scope of this document and should be referenced externally.

Contact support@interactivedialogues.com for more information on using this feature.
Help

EDG contains the following sections that provide guidance to developers of e-Dialogues.

- Getting started guide
- User guide
- What's new?
- About e-Dialogues

Getting started guide

This guide can be found by selecting Help and then Getting started guide. The aim of this document is to assist the inexperienced ED author in building their first simple ED.

User Guide

This guide can be found by selecting Help and then User Guide. The aim of this document is to assist the ED author in all aspects of using the EDG tool.

What's new?

This text document can be accessed by selecting Help and then What's new. The aim of this document is to assist the experienced ED author by providing information on all of the changes that have been made to the software in most recent update.

About e-Dialogues

Information on e-Dialogues can be found by selecting Help and then About e-Dialogues. This tab contains the following information:-

- The current EDG version number
- Interactive Dialogues support contact details
- Register function that allows an author to extend their licence or show the number of days left on the licence.
Analysis

Once an e-Dialogue has been scheduled to a target audience, EDG can be used to download and analyse the data.

To demonstrate this, create a short e-Dialogue and upload to DMS as shown in Figure 161.

Configure the schedule for anonymous participants and run the link a number of times to generate data.

Generate a report in DMS to verify the data has been collected correctly as shown in Figure 162.

EDG can be used to produce two types of report:

- **Export**: an Excel export of the raw data.
- **Report**: a Word or HTML file containing counts/percentages and graphs for each question.

Note: Reports can be generated in DMS but take longer to generate as they have to retrieve data from the server. If multiple reports are to be generated then it is advisable to download the data to EDG.
**Exporting the raw data**

To produce a raw data export select Analysis then Export to display the Export Results box as shown in Figure 163.

Select the output file format from HTML, XML, CSV or SPSS by using the Output File Format drop down list box.

To get the most recent data select Download the latest data from the Web server and then select the schedule/s.

For subsequent reports, the option Local stored data previously downloaded from the Web Server can be used to speed up the reporting process.

Once all the options on Step 1 of 3 have been selected click Next to move on to Step 2 of 3.

**Tip**: For an SPSS format select the SPSS SAV format from the drop down list box.

If the ED is still at the development stage then an example report can be generated using random data. It is always recommended that this should be done before an live release is done as it can highlight any unexpected errors.

To base the report on random data tick the Randomly generated test data tick box and then enter a realistic number of samples in the box provided.
Step 2, as shown in Figure 164, is used to choose which questions will be included in the report. If the report is required to display results for all questions then the **All Questions** should be selected. If the report is required to only contain data from certain questions then the **Selected questions...** option should be selected and the individual questions highlighted by left clicking on them with the mouse.

**Figure 164**

Step 3, as shown in Figure 165, is used to configure the schedule filter and provides the following options:

<table>
<thead>
<tr>
<th>Filter name</th>
<th>Filter function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Between dates</td>
<td>Filters on users who have started an e-Dialogue between two defined dates.</td>
</tr>
<tr>
<td>By Groups</td>
<td>Filters on users who are in specific groups within the schedule participants list.</td>
</tr>
<tr>
<td>By Language</td>
<td>Filters on users based on the language they select to view the e-Dialogue in.</td>
</tr>
<tr>
<td>On Completion Status</td>
<td>Filters on users who have completed the e-Dialogue only.</td>
</tr>
<tr>
<td>On Score</td>
<td>Filters on users who have achieved higher or lower than a set score.</td>
</tr>
<tr>
<td>On specific answers to questions</td>
<td>Filters on users who gave a specific answer to a set question or questions.</td>
</tr>
<tr>
<td>On the users name</td>
<td>Filters on users based on their name from the DMS system.</td>
</tr>
<tr>
<td>On ‘Extra’ user information</td>
<td>Filters on the extra user information that can be specified for each user.</td>
</tr>
<tr>
<td>Demographics</td>
<td>An extra filter option is added for each single choice component that is marked as a demographic. This can be done at any stage in the question component options.</td>
</tr>
</tbody>
</table>

**Figure 165**
Once all the required filters are selected click **Finish** to produce the report, an example of which is shown in Figure 166.

![Figure 166](image)

**Note:** Due to the restriction in excel that limits a page to 256 columns it is not advised to have more than 256 question options in an ED. If there are more than 256 question options, the export columns and rows are exchanged. The limitation is then that there can be no more than 256 user responses. This issue is resolved in Excel 2007.
**Producing a standard report**

To generate a report select **Analysis** and then **Create Report** to open Step 1 of 4 as shown in Figure 167.

![Figure 167](image)

There are three levels of report that can be generated with increasing detail:

1. **Simple**: standard counts/percentages and charts for each question displaying counts and percentages
2. **More Detailed Report**: standard tables, charts and statistics tables
3. **Custom Report**: in depth analysis on individual questions or complete cross tabulation based on a demographic

Select simple or more detailed report from the radio button list at the top.

To get the latest data it is necessary to download the data from DMS. To do this tick the option marked **Download the latest data from the Web Server**, as shown in Figure 168, and the left click on the schedule/s that are to be used to download the data-set.

For subsequent runs of the report, the option **Local stored data previously downloaded from the Web Server** can be used to speed up the reporting process.

Randomly generated test data can be used to verify a reporting format at the post-development stage. To show a report with random data tick the **Randomly generated test data** button and enter a number in the samples box. This number will represent the number of simulated users in the test group.

The settings for Steps 1 to 4 can be saved by giving the configuration a name using the **Analysis Name: (Optional)** tab at the bottom of the box. This can then be subsequently accessed by selecting **Analysis** and then the saved name from the build window.
On step 2 of 4, as shown in Figure 169, select either **All questions** or **Selected questions**, highlight the chosen questions and click **Next** to move to Step 3 of 4.

Figure 168

Step 3, as shown in Figure 170, is used to configure the filter and provides the following options.

<table>
<thead>
<tr>
<th>Filter name</th>
<th>Filter function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Between dates</td>
<td>Filters on users who have started an e-Dialogue between two selected dates.</td>
</tr>
<tr>
<td>By Groups</td>
<td>Filters on users who are in specific groups within the schedule participants list.</td>
</tr>
<tr>
<td>By Language</td>
<td>Filters on users based on the language they select to view the e-Dialogue.</td>
</tr>
<tr>
<td>On Completion Status</td>
<td>Filters on users who have completed the e-Dialogue only.</td>
</tr>
<tr>
<td>On Score</td>
<td>Filters on users who have achieved higher or lower than a selected score.</td>
</tr>
<tr>
<td>On specific answers to questions</td>
<td>Filters on users who gave a specific answer to a question.</td>
</tr>
<tr>
<td>On the users name</td>
<td>Filters on an individual user.</td>
</tr>
<tr>
<td>On ‘Extra’ user information</td>
<td>Filters on the extra user information (User1-10) that can be specified for each user.</td>
</tr>
<tr>
<td>Demographics</td>
<td>An extra filter option is added for each single choice component that is marked as a</td>
</tr>
</tbody>
</table>
Figure 170

Figure 170 to Figure 179 show each of the filters and their criteria.
Figure 175 to Figure 177 demonstrate how to configure the filter for users who have selected a specific option on a specific question.

Figure 176

Figure 177
Once the filter criteria are configured, click **Next** to move on to step 4 of 4. Step 4, as shown in Figure 180, is used to define the output of the report.

The report output format can be chosen between the following options:-

- **HTML**: Web page with all counts/percentages and charts (displayed in the **Report Output** tab of the main window)
- **RTF**: Document with all counts/percentages and charts that can be saved in word format
- **XML**: Excel report of raw data

Additional data, from the schedule in DMS, can also be included by ticking the box marked **Show respondents details** and then select one or more of the following options:-

- **Name**: the user's name
- **Username**: the user's username
- **E-mail**: the user's email address
- **Group**: the group the user is part of within the schedule
- **Start Date**: the date the schedule started
- **End Date**: the date the user completed
- **Total time**: the total time the user spent on the e-Dialogue
• **Status**: the completion status of the user
• **Score**: the user's score
• **Answered**: the number of questions the user answered that had a correct answer assigned
• **Language**: the language the user chose to view the e-Dialogue in

Each question can be displayed on a separate page for RTF reports by clicking on the **Add Page Break after each Question** option at the bottom of the box.

To change the default font setting from Arial tick the **Use a different font** box and then click on the **Specify** button to choose a different one.

![Figure 180](image1.png)

**Analysing individual questions**

Individual questions can be analysed in depth by choosing the **Custom Report** option on Step 1.

![Figure 181](image2.png)
To add a question and define the parameters click on the + icon to display the Analyse Question box as shown in Figure 183.

To cross tabulate all the questions by a demographic question click on the Add All Questions by Demographic button to bring up the Crosstab by Demographic box as shown in Figure 182. Select the demographic question using the drop down list box.

![Crosstab by Demographic](image)

**Figure 182**

To add a title and extra text to the report, click on the General tab and enter the text.

![Analyse Question](image)

**Figure 183**

To select the question click on the Question tab, as shown in Figure 184, select the page using the On page: drop down list and the question using the Question: drop down list.

Tick the Show the questions text tick box if it is required that the question text is displayed in the report.

Tick the Show Frequency Table tick box if a frequency table is required.

Tick the Show Frequency Graph tick box and pick a type of graph to be shown if a graph is required for the question.

If the data for the question is ordinal i.e. there is a progression between options, then tick the Data is Ordinal button. If there is no progression the tick the Data is Nominal button. An example of ordinal is 1,2,3 and an example of nominal is red, blue, green.

Tick the Show Statistics Table tick box if a statistics table is required for the question.

Tick the Show Statistics Chart tick box if a statistics chart is required for the question.
Tick the **Exclude bad data** tick box if it is required that “bad data” i.e. data that is +/- 1.5 standard deviations away from the mean is removed.

![Figure 184](image)

To set weighting or to exclude data for any option click on the **Weighting/Missing Data** tab, as shown in Figure 185. Each option has a default weighting of 1 so that each answer carries equal weight. To exclude an option set the option weighting to 0. To set the option weighting higher enter the value under the option **Weighting**.

![Figure 185](image)

To cross tabulate the question with one other question click on the **Cross tabulation** tab, as shown in Figure 186. Select the page and question at the top of the box and then tick the statistics options at the bottom that are required.
Example reports

Some example reports are shown below.

Figure 187 and Figure 188 show a simple report for question 1 of the e-Dialogue in the build window.

Figure 189 and Figure 190 show an Extra Detailed Report on question 2 of the e-Dialogue in the build window.

Figure 191 and Figure 192 show a Custom Report on question 2 of the e-Dialogue in the build window.
Figure 188

Figure 189
Figure 192

Note: any part of the report can be transferred to a word processing package via standard windows copy and paste.
EDGE add-ons

There are a number of additional features that can be added onto EDGE that give functionality outside the standard surveys and e-learning modules.

These add-ons are accessed via a new unlock code and appear automatically as soon as they are unlocked.

Panel Management

Panel management is a market research style functionality that allows groups to be built in DMS where members are chosen based on answers to a panel profile ED.

A client would normally use this feature in the following way:-

1. An anonymous schedule with auto-registration would be used to capture the user’s basic details and panel information such as marital status, home owner or not, gender etc. This information would be kept and used as criteria for every time a new market research questionnaire was to be released.
2. A new permanent user record would be created in DMS so that each user had a homepage and a way of managing their ED progress.
3. When market research information is needed, the group that are to be scheduled are selected by filtering on the panel answers from the panel ED.
4. The resulting ED questionnaire on men’s hair-care products is only scheduled to men between fifteen and fifty. A questionnaire on pet food would only go out to user’s that own a cat or a dog etc.

To construct a panel group follow the instructions below. It is assumed that a panel ED has been used to collect and download data to EDGE.

Select Analysis then Create Panel Group to bring up the DMS Group builder window as shown in Figure 193.

If there could be an issue where users are over-exposed to the system and could be asked to complete too many surveys then the maximum amount that they can be asked to do in a given time period is set using the exclude participants option.

If the panel ED used to collect the data is in a continuous schedule within DMS then the latest data should be downloaded each time a panel group is created. If the panel ED schedule is already complete then the data should only be download initially and then local data used when creating subsequent panel groups.

![DMS Group Builder](image)

**Figure 193**

Click the Next button to get to the filter stage and use the standard filter options as discussed in the reporting section to construct the panel group criteria. Click on the Next button again to display all the users that meet the panel criteria, as shown in Figure 194.
To manually delete users from the list click on the user and then press the delete button on your keyboard. To delete multiple users hold down the Ctrl button and individually click on each user then press delete. To delete blocks of users hold down Shift, click on the first user in the block, then the last user and then press delete.

To randomly narrow the list down to a set number of users enter the value in the Select at random from this list box and press Go.

Once the list is correct enter a name that will be used in DMS and click on Create DMS Group.

Log onto the DMS and check that the group has been successfully created and the expected numbers of users are held in it, as shown in Figure 195.